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BAB III 

METODOLOGI PENELITIAN 

 

A. Tempat dan Waktu Penelitian 

Adapun tempat pelaksanaan penelitian ini yaitu di SMKN I Sintuk 

Toboh Gadang kelas X BOGA. Sedangkan waktu penelitian ini adalah 

semester  II (Genap), tahun pelajaran 2017/2018. 

B. Metode Penelitian 

Penelitian ini merupakan penelitian kuantitatif. Penelitian kuantitatif 

adalah tipe penelitian yang datanya dikumpulkan berupa data kuantitatif atau 

jenis data lain yang dapat dikuantitaskan, dan diolah dengan menggunakan 

teknik statistik. Adapun jenis penelitiannya yaitu penelitian eksperimen 

(eksperiment research). Penelitian eksperimen (eksperiment research) 

merupakan suatu penyelidikan yang dirancang sedemikian rupa sehingga 

fenomena atau kejadian itu dapat diisolasi dari pengaruh – pengaruh lain. 

Dalam penelitian eksperimen, peneliti dapat memanipulasi variabel bebas dan 

mengatur situasi penelitian dengan benar sehingga dapat mengungkapkan 

faktor–faktor sebab akibat. Dalam penelitian ini ada kelompok kontrol dan 

kelompok eksperimen. 

Jenis penelitian eksperimen yang digunakan dalam penelitian ini adalah 

quasi eksperimen atau eksperimen semu, sedangkan rancangan yang 

digunakan dalam penelitian ini adalah Randomized Control Group Only 

Desig. Dalam hal ini, sekelompok subjek yang diambil dari populasi tertentu 
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dikelompokkan secara rambang menjadi dua kelompok yaitu kelompok 

kontrol dan kelompok eksperimen. Kelompok eksperimen dikenai perlakuan, 

yaitu kelompok eksperimen diterapkan strategi pembelajaran PQ4R pada 

mata pelajaran PAI. Sedangkan kelompok kontrol diterapkan strategi 

pembelajaran langsung (SPL).
1
 Menurut Suryabrata, jenis eksperimen 

Randomized Control Group Only Design dapat digambarkan sebagai berikut : 

Tabel 3.1 

Rancangan Penelitian 

Kelas Sampel Perlakuan Tes  

Kelas Eskperimen X1 T1 

Kelas Kontrol X2 T2 

 

Keterangan: 

X1 = Pembelajaran dengan menggunakan strategi PQ4R 

X2 = Pembelajaran dengan strategi pembelajaran langsung 

T1 = Tes akhir pada kelas Eksperimen 

T2 = Tes akhir pada kelas control 

 

C. Populasi dan Sampel 

1. Populasi 

 Adapun yang menjadi populasi dari penelitian yang akan penulis 

lakukan ini adalah semua peserta didik kelas X jurusan BOGA SMKN 1 

Sintuk Toboh Gadang terdiri dari tiga lokal. Data jumlah peserta didik 

kelas X BOGA SMKN 1 Sintuk Toboh Gadang dapat dilihat dari tabel 

berikut ini: 

                                                           
1
Sumadi, Suryabarata, Metode Penelitian, (Jakarta : Raja Grafindo, 2013), h. 104 
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Tabel 3.2 

Jumlah Peserta Didik Kelas X BOGA SMKN 1 SINTOGA  

No Kelas Jumlah Peserta Didik 

1. X.BOGA.1 30 

2. X.BOGA.2 30 

3. X.BOGA.3 32 

Total  92 

    Sumber:  Guru PAI Kelas X BOGA SMKN 1 SINTOGA  

2. Sampel  

 Sampel merupakan bagian dari populasi dan dapat mewakili 

populasi tersebut, pengambilan sampel ini dilakukan dengan secara acak 

di kelas X BOGA SMKN 1 Sintuk Toboh Gadang Kab. Padang Pariaman 

sebagai sampel yaitu kelas X BOGA 1 dengan jumlah peserta didik 30  

orang dan kelas X BOGA 2 dengan jumlah peserta didik 30 orang. 

 Berikut ini adalah langka,h-langkah yang harus dilakukan 

dalam pengambilan sampel yaitu: 

a. Mengumpulkan data nilai ujian semester I PAI peserta didik kelas X 

BOGA SMKN 1 Sintuk Toboh Gadang Kab. Padang Pariaman Tahun 

Pelajaran 2016/2017. Dari nilai ujian semester I dilakukan 

perhitungan sehingga diperoleh data mengenai rata-rata ( X ), 

simpangan baku (S), dan skor tertinggi (Xmax) dan skor 

terendah (Xmin). Untuk lebih jelasnya lihat dilampiran I 

b. Melakukan uji normalitas, terhadap nilai semester I. Uji normalitas 

bertujuan untuk mengetahui apakah data yang diambil berdistribusi 

normal atau tidak. Uji normalitas menggunakan program SPSS versi 
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22 adapu langkah-langkahnya yaitu Memasukan data hasil belajar 

peserta didik BOGA 1, 2, dan 3 > Klik Analyze > Descriptive 

Statistics > Explore > Dependent List > Plots > Klik Faktor Levels 

Together > Klik Histogram > Klik Normality Plots With Test > Klik 

Continue. Untuk lebih jelasnya lihat lampiran II 

c. Melakukan uji homogenitas uji ini bertujuan melihat apakah populasi 

mempunyai farian yang homogen atau tidak. Uji yang digunakan 

memakai program SPSS versi 22. Untuk lebih jelasnya bisa dilihat 

dilampiran II 

d. Melakukan uji kesama rata-rata, uji kesama rata-rata bertujuan untuk 

mengetahui apakah populasi memiliki kesamaan atau tidak uji yang 

digunakan memakai program SPSS versi 22. 

e. Pengambilan sampel, setelah dilakukan uji normalitas, uji 

homogenitas dan uji kesamaan rata-rata, disipulkan bahwa ketiga 

populasi merupakan kelas yang bertribusi normal, homogen dan 

kesamaan rata-rata tidak jauh berbeda. Maka pengambilan sampel 

dilakukan dengan pengundian nomor yang diambil dua nomor secara 

acak. Nomor yang yang pertama dijadikan sebagai kelas eksperimen 

dan nomor yang kedua dijadikan kelas kontral, cara ini disebut cluster 

random sampling. Untuk kelas eksperimen terpilih kelas X BOGA 1 

sedangkan kelas kontrol terpilih kelas X BOGA 2 seperti tabel di 

bawah ini. 
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                                         Tabel 3.3 

Peserta didik kelas X BOGA 1 dan 2 

SMKN 1 Sintuk Toboh Gadang 

NO Kelas Jumlah 

1 Eksperimen 

X BOGA 1 

30 Orang 

2 Kontrol 

X BOGA 2 

30 Orang 

 Total 60 Orang 

  

D. Variabel dan Data 

1. Variabel 

Dalam penelitian ini terdiri dari 2 variabel: 

a. Variabel bebas 

  Variabel bebas yaitu perlakuan yang diberikan pada sampel 

penelitian yaitu pembelajaran yang menerapkan strategi 

pembelajaran PQ4R dan SPL. 

b. Variabel terikat  

  Variabel terikat yaitu variabel yang dipengaruhi oleh 

variabel bebas. Sebagai variabel terikat dalam penelitian ini adalah 

hasil belajar peserta didik pada mata pelajaran PAI yang diperoleh 

pada akhir pertemuan yang sebelumnya diberikan perlakuan. 

2. Data 

 Data dalam penelitian ini berupa data primer yaitu hasil belajar 

mengunakan strategi PQ4R  dan SPL pada peserta didik kelas X BOGA 

1 dan X BOGA 2 SMKN 1 Sintuk Toboh Gadang  pada ranah kognitif 
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yang diperoleh dengan memberikan tes diakhir pembelajaran pada kelas 

sampel. 

E. Prosedur Penelitian 

Prosedur penelitian ini dibagi atas tiga tahap yaitu : 

1. Tahap Persiapan 

a. Menentukan tempat dan jadwal penelitian 

b. Menetapkan materi pembelajaran, materi pembelajar saat penelitian 

dilakuakan bertepatan dengan materi sumber hukum Islam  

c. Menentukan populasi dan sampel untuk kelas eksperimen dan kelas 

kontrol. Populasi dalam penelitian ini ialah semua peserta didik kelas 

X BOGA  dan yang menjadi sampel terpilih X BOGA 1 dan X 

BOGA 2 SMKN 1 Sintuk Toboh Gadang. 

d. Mempersiapkan perangkat pembelajaran yang akan dilaksanakan, 

rencana pelaksanaan pembelajaran (RPP) 

e. Mempersiapkan instrument penilaian untuk tes akhir. 

 

2. Tahap Pelaksanaan 

 Pembelajaran pada kelas eksperimen dan kelas kontrol adalah sama 

dari segi materi. Kedua kelas sampel hanya dibedakan dalam strategi 

pembelajaran yang digunakan. Pembelajaran di kelas eksperimen dan 

kelas kontrol dapat dilihat pada tabel berikut : 
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Tabel 3.4 

Kegiatan Pembelajaran Pada Kelas Eksperimen dan Kontrol 

Kelas eksperimen Kelas kontrol 

1. Pendahuluan (15 menit) 

a. Guru memeriksa kesiapan 

peserta didik, sarana dan 

media dalam pembelajaran 

serta absensi 

b. Guru memberikan apersepsi 

c. Guru memberikan motivasi 

agar peserta didik lebih aktif 

d. Guru menyampaikan tujuan 

pembelajaran 

2. Kegiatan Inti (100 menit) 

a. Guru memberikan 

pengetahuan dasar untuk 

memudahkan peserta didik 

memahami materi pelajaran 

b. Guru menjelaskan bagaimana 

prosedur pembelajaran 

c. Guru menjelaskan secara 

singkat tentang materi yang 

akan diterapkan 

d. Guru membagikan bahan 

bacaan setiap peserta didik 

untuk dipelajari 

e. Peserta didik membaca bahan 

bacaan dan kemudia 

menemukan intisari dari 

bacaan tersebut 

f. Guru meminta peserta didik 

untuk tampil kedepan 

menjelaskan apa yang 

diperoleh oleh peserta didik 

atas apa yang dibaca 

g. Guru memberikan 

kesempatan kepada peserta 

didik untuk menanyakan apa 

saja yang belum dipahami 

 

3. Kegiatan Penutup (20 menit) 

a. Peserta didik dengan 

bimbingan guru 

menyimpulkan materi yang 

dibahas 

b. Guru memberikan keterangan 

1. Pendahuluan (15 menit) 

a. Guru memeriksa kesiapan 

peserta didik, sarana dan 

media dalam pembelajaran 

serta absensi 

b. Guru memberikan apersepsi 

c. Guru memberikan motivasi 

agar peserta didik lebih aktif 

d. Guru menyampaikan tujuan 

pembelajaran 

2. Kegiatan Inti (100 menit) 

a. Guru memberikan 

pengetahuan dasar untuk 

memudahkan peserta didik 

memahami materi pelajaran 

b. Guru meminta peserta didik 

untuk mempersiapkan buku 

PAI kls X dan alat tulis 

c. Guru menjelaskan secara 

sempurna tentang materi 

yang diterapkan 

d. Guru meminta peserta didik 

untuk mencatat hal-hal yang 

menurut penting oleh peserta 

didik 

e. Guru mengajukan pertanyaan 

untuk di diskusikan setelah 

guru menjelaskan materi 

pelajaran 

f. Peserta didik bergabung 

dengan tim atau anggotanya 

yang telah ditentukan 

g. Peserta didik berdiskusi 

untuk menyiapkan jawaban 

dari pertanyaan yang 

diajukan oleh guru 

h. Guru meminta perwakilan 

dari masing-masing 

kelompok untuk melaporkan 

hasil diskusinya 

i. Guru mengamati hasil yang 

dikemukakan oleh masing-

masing kelompok. 
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tentang hasil pembelajaran 

masing-masing peserta didik 

c. Guru memberikan pekerjaan 

rumah dan tugas membaca 

materi yang akan dipelajari 

pada pertemuan berikutnya. 

3. Kegiatan Penutup (20 menit) 

Peserta didik dengan bimbingan 

guru menyimpulkan materi yang 

dibahas 

Guru memberikan keterangan 

tentang hasil diskusi 

Guru memberikan pekerjaan 

rumah dan tugas membaca materi 

yang akan dipelajari pada 

pertemuan berikutnya. 

 

 

3. Tahap Penyelesaian 

1) Memberikan tes akhir kepada kedua kelas sampel setelah penelitian 

berakhir, guna melihat hasil perlakuan yang telah diberikan 

2) Mengolah data dari kedua sampel, baik kelas eksperimen maupun 

kelas kontrol 

3) Menarik kesimpulan dari hasil yang didapat sesuai dengan teknik 

analisis data yang digunakan. 

F. Instrumen Penelitian 

 Instrumen penelitian adalah suatu alat atau fasilitas yang digunakan untuk 

mengukur fenomena alam maupun sosial yang diamati. Instrument yang 

digunakan adalah berisi tes yang diberikan kepada sampel yang diteliti, 

berbentuk soal objektif yang terdapat pilihan ganda antara A sampai E setelah 

akhir penelitian. Tes ini sesuai dengan materi yang diberikan selama pelakuan 

berlangsung. Peserta didik dapat memilih soal yang dianggap benar. Jika 

peserta didik menjawab benar maka mendapatkan skor 2,5 dan jika peserta 

didik salah maka tidak mendapatkan skor atau 0. 
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 Agar instrumen merupakan alat ukur yang baik, maka dilakukan langkah-

langkah sebagai berikut: 

a. Membuat kisi-kisi soal berdasarkan kompetensi dasar dan indikator dan 

materinya. Kisi-kisi soal pada penelitian ini tentang sumber hukum Islam 

dengan jumlah soal objektif sebanyak 40 butir. Untuk lebih jelasnya lihat 

dilampiran III 

b. Mempersiapkan soal tes akhir yang digunakan dalam penelitian 

berdasarkan kisi-kisi yang telah disusun. Bisa dilihat di lampiran IV 

c. Melakukan uji coba soal pada kelas lain yang sederajat. Maka dalam uji 

coba soal di pakai kelas X BOGA 3 yang KKMnya sama dan guru yang 

sama. 

d. Dari hasil uji coba, dilakukan analisis soal secara statistik untuk 

mengetahui validitas, reliabilitas, daya beda, dan tingkat kesukaran soal 

agar didapat instrumen yang baik. 

e. Dari hasil di atas maka diperoleh soal-soal tes akhir. 

1. Validitas 

 Arikunto mengatakan bahwa sebuah tes dikatakan memiliki 

validitas isi apabila dapat mengukur tujuan khusus tertentu yang sejajar 

dengan materi atau isi pelajaran yang diberikan. Jadi suatu soal dikatakan 

valid apabila soal itu dapat mengukur apa yang hendak diukur. 
2
 

 Setelah instrumen disusun sesuai kisi-kisi yang dibuat, kemudian 

instrumen tersebut divalidasi oleh dua orang validator yaitu Agusrizal 

                                                           
2
 Suharismi Arikunto, Dasar-dasar  Evaluasi  Pendidikan,  (Jakarta: Bumi Aksara, 2002), 

h. 74 



65 
 

 

M.Ag sebagai guru PAI kelas X  BOGA SMKN 1 Sintuk Toboh Gadang 

dan satu orang dosen fakultas tarbiah dan keguruan yakni Ibu Zulvia 

Trinova, S.Ag. M.Pd. 

 Di samping validasi oleh validator di atas selanjutnya dilakukan 

pula validitas tes. Validitas tes perlu ditentukan untuk mengetahui kualitas 

tes dalam kaitannya dengan mengukur hal yang seharusnya diukur. Ada 

empat jenis validias, yaitu validitas isi (contens validity), validitas 

konstruk (construct validity), validitas prediktif (predictive validity), dan 

validitas konkuren (concurent validity). 

 Dalam penyusunan instrumen, peniliti berpedoman pada validitas 

isi. Apabila tes yang disusun sudah berdasarkan kisi-kisi yang telah dibuat, 

maka tes telah memenuhi validitas isi. Untuk mengetahui tingkat 

kevalidan soal uji coba tersebut, bisa dicari dengan menggunakan 

microsoft excel. Validitas dalam penelitian ini diuji coba kepada peserta 

didik  X BOGA 3 SMKN 1 Sintuk Toboh Gadang. 

Hasil pencarian validitas tes tersebut diketahui bahwa dari 40 soal, 

terdapat 29 soal yang valid dan 11 soal yang tidak valid. Untuk soal yang 

valid yaitu soal nomor  2, 4, 5, 6, 9,10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 

21, 22, 23, 25, 26, 27, 28, 29, 31, 32, 33, 35, 39, 40. Sedangkan soal yang 

tidak valid yaitu soal nomor 1, 3, 7, 8, 20, 24, 30, 34, 37, 38. Untuk lebih 

jelasnya liat lampiran V 
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2. Reliabilitas Tes 

Reliabilitas suatu tes merupakan tingkat kepercayaan dari tes 

tersebut. Untuk menentukan reliabilitas tes digunakan SPSS versi 22 dan 

bisa juga dilakukan secara manual memakai rumus yang dikemukakan 

oleh Kuder dan Richardson seperti di bawah ini:
3
 

r11 = 








1n

n







 


)(n)(St

Mt)Mt(n
1

2
 

Keterangan:

 r11 = Reliabilitas tes secara keseluruhan

 n = Jumlah item soal

 1 = Bilangan konstan 

Mt = Mean total ( Rata-rata hitung dari skor total ) 

 St
2 

= Varian total 

 

         Tabel 3.5 Taksiran Kriteria Reliabilitas: 

Reliabilitas Kategori 

0,90  <  r11  1,00 Reliabilitas sangat tinggi 

0,70  <  r11   0,90 Reliabilitas tinggi 

0,40  <  r11  0,70 Reliabilitas sedang 

0,20  <  r11  0,40 Reliabilitas rendah 

0,00  <  r11  0,20 Reliabilitas sangat rendah 

 

 

Kriteria reliabilitas yang dipakai dalam penelitian ini berkisar 

antara 0,40 sampai dengan 0,70. 

Di dalam penelitian ini, mencari reliabilitas memakai SPSS versi 

22 dengan langkah-langkah seperti berikut: klik analys > klik scale > klik 

realibility analis > dan masukan data kekotak kanan. 

                                                           
3
Ibid, h. 103 
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Maka didapatkan hasil reliabilitas tes yaitu 0,63 yang berarti tes 

mempunyai reliabilitas yang sedang. Untuk lebih jelasnya dilihat di 

lampiran VI 

3. Indeks/Tingkat Kesukaran Soal 

Indeks kesukaran soal digunakan untuk melihat apakah soal 

tersebut termasuk soal yang mudah, sedang, atau sukar. Angka indeks 

kesukaran soal dapat diperoleh dengan menggunakan rumus. 

P =
Js

B
 

Keterangan : 

P =  Angka indeks kesukaran soal 

B =  Banyaknya siswa yang dapat menjawab soal dengan betul 

Js =  Jumlah siswa yang mengikuti tes hasil belajar. 

 

P =
Js

B

 

70,0
32

22
P

 
 

 

Untuk lebih jelasnya soal berikutnya dapat dilihat dilampiran VI 

 
Kriteria : 

Kurang dari 0,25 =  Terlalu sukar 

0,25 – 0,75   =  soal cukup (sedang) 

Lebih dari 0,75 =  Terlalu mudah  

 

Kriteria indeks kesukaran soal yang dipakai dalam penelitian ini 

berkisar antara 0,25 sampai dengan 0,75 Dikatakan sedang. 
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4. Daya Pembeda Soal 

Daya pembeda soal merupakan kemampuan sesuatu soal untuk 

membedakan antara peserta didik yang pandai (berkemampuan tinggi) 

dengan peserta didik  berkemampuan rendah.
4
 Maka menentukan daya 

pembeda disini memakai Mickrosof exel dapat dilihat dilampiran V 

D = PA  -  PB 

PA =
BA

JA
   dan  PB =

BB

JB
 

Keterangan : 

D =   Discriminatory power (angka indeks kesukaran item) 

PA = Proporsi peserta kelompok atas yang dapat menjawab 

dengan  betul    butir item yang bersangkutan 

PB =  Proporsi peserta kelompok bawah yang dapat menjawab 

dengan betul butir item yang bersangkutan  

BA = Banyaknya peserta kelompok atas yang dapat menjawab 

dengan betul butir item yang bersangkutan 

BB =  Banyaknya peserta kelompok bawah yang dapat 

menjawab dengan betul butir item yang bersangkutan 

J =   Jumlah peserta tes 

JA = Jumlah pesertayang termasuk dalam kelompok atas 

JB =   Jumlah peserta yang termasuk dalam kelompok bawah 

 

Kriteria : 

Kurang dari 0,20 =  Jelek 

0,20 – 0,40  =  Cukup (sedang) 

0,40 – 0,70  =  Baik 

0,70 – 1,00  =  Baik Sekali 

Bertanda Negatif =  Jelek sekali 

 

Kriteria daya pembeda soal yang dipakai dalam penelitian ini 

berkisar antara 0,20 sampai dengan 1,00. 

 

                                                           
4
 Ibid, h. 389 
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G. Teknik Analisis Data 

Analisis data hasil penelitian ini menggunakan metode statistik untuk 

melihat keberhasilan peserta didik dalam belajar, yang menentukan 

pengolahan datanya dilakukan dengan uji normalitas dan uji homogenitas. 

Untuk lebih jelasnya uji normalitas ini dapat dilihat lampiran VII  

1. Uji Normalitas 

  Uji  normalitas  data  dilakukan  untuk  mengetahui apakah data 

yang diperoleh didistribusikan normal atau tidak. Pengujian  normalitas  

data menggunakan  SPSS versi 22. Dengan kriteria pengujian  terima Ho 

apabila  ttabel <  thitung < ttabel , ttabel = t1 - 
1

2
𝛼 distribusi t dengan derajat  

kebebasan  dk =  n1 +   n2-  2,  taraf  signifikan 5%  dan tolak H0  untuk 

harga t  lainnya. Pengujian  normalitas  data  dengan menggunakan 

program SPSS versi 22 dengan langkah-langkah : Memasukan data hasil 

belajar kelas eksperimen dan kelas kontrol > Klik Analyze > Descriptive 

Statistics > Explore > Dependent List > Plots > Klik Faktor Levels 

Together > Klik Histogram > Klik Normality Plots With Test > Klik 

Continue.
5
 Untuk lebih jelasnya lihat dilampiran VII 

 

2. Uji Homogenitas 

Uji ini digunakan untuk mengetahui apakah kelompok eksperimen  

dan kelompok kontrol yang  ditetapkan  berasal dari populasi yang 

memiliki varian yang relatif sama. Rumus yang digunakan untuk 

                                                           
5
 Getut Pramesti, Smart Olah Data Penelitian dengan SPSS 21, (Jakarta: Elex Media 

Komputindo, 2013), h. 15 
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mengujinya menurut Sudjana atau bisa juga menggunakan program SPSS 

versi 22 . Rumus yang digunakan Sudjana adalah: 

2

2

2

1S

S
F   

Keterangan: 

S1
2 

= variansi hasil belajar kelas eksperimen 

S2
2 

= variansi hasil belajar kelas kontrol 

 

Hipotesis yang diajukan: 

:0H  sampel mempunyai varians yang sama  

Ha :  sampel mempunyai varians yang tidak sama 

Kriteria pengujian: 

Apabila Fhitung < Ftabel  maka  data  berdistribusi homogen Ha 

ditolak. H0 diterima berarti varians homogen. Pengujian homogenitas  

data dalam penelitian ini menggunakan program SPSS versi 22 dengan 

langkah-langkah berikut: Memasukan data hasil belajar kelas 

eksperimen dan kelas kontrol >  Klik Analyze > Klik Compare Means 

> Klik One Way ANOVA > Dependent List > Klik Options > Klik 

Descriptive > Klik Homogenety of variance test > Klik Means Plot > 

Klik Continue. Untuk lebih jelasnya lihat dilampiran VII 

3. Pengujian Hipotesis 

  Setelah  sampel diberi perlakuan yang berbeda, maka dilaksanakan 

tes akhir. Teknik statistik yang digunakan adalah teknik  t-test  untuk 

menguji  signifikansi  perbedaan  dua  buah mean  yang  berasal  dari  dua  

buah  distribusi.  Pada  penelitian ini,  data  yang  digunakan  pada  

perhitungan  ini  adalah  data test.  Dari  hasil  tes  akhir  ini  akan  
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diperoleh  data  yang digunakan  sebagai  dasar  dalam menguji  hipotesis  

penelitian, yaitu hipotesis diterima atau ditolak. Pengujian hipotesis yang 

digunakan adalah sebagai berikut :  

Ho : Hasil belajar PAI peserta didik kelas eksperimen sama dengan 

hasil belajar kelas kontrol. 

H1 :  Hasil belajar PAI peserta didik kelas eksperimen lebih baik 

dari pada hasil belajar peserta didik kelas kontrol. 

  Untuk menguji hipotesis digunakan uji kesamaan dua rata-rata. 

Hasil uji normalitas dan uji homogenitas, data terdistribusi normal dan dua 

kelompok data mempunyai varians yang homogen, maka digunakan uji t 

dengan rumus : 

           t =        dengan         s
2
 =  

              Ket: = Skor rata-rata nilai kelas eksperimen 

                        = Skor rata-rata kelas kontrol 

                s
2 

= Variansi dari kedua sampel 

                n1 = Jumlah peserta didik kelas eksperimen 

                n2 = Jumlah peserta didik kelas kontrol. 

 

  Kriteria hipotesis diterima jika thitung > t  dilihat pada daftar  

distribusi t dengan derajat kebebasan df = n1 + n2 - 2 dan peluang . 

Hipotesis ditolak jika thitung ≤ t  dilihat pada daftar distribusi t dengan 

derajat kebebasan df = n1 + n2 - 2 pada taraf signifikan 0,05. Untuk lebih 

jelasnya lihat lampiran VIII 
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